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BEFORE YOU START 

About This Document 
This document is designed to be a reference guide for the System Administrator or Manager of the FreshDate 3 system 
used to create food freshness labels.  

We recommend reading this document in its entirety before starting. It contains an overview of the system, setup 
instructions, and basic user instructions. Complete instructions are found in the Help and About sections of the printer 
and the applications.  

The FreshDate 3 Quick Guide is also provided with each system. It provides the main operational instructions such as 
logging in, loading labels and printing labels. 

Proprietary Statement 
The FreshDate software and this manual are proprietary products of MedVantage Inc. and are protected by United States 
and foreign copyright laws. The manual is intended solely for the information and use of parties operating and 
maintaining the system described herein and may not be used, reproduced, or disclosed to any other parties for any other 
purpose without the express written permission of MedVantage, Inc.  

Product Improvements 
Continuous improvement of products is a policy of MedVantage. All specifications and designs are subject to change 
without notice. 

Liability Disclaimer 
MedVantage takes steps to ensure that it’s published specifications and manuals are correct; however, errors do occur. 
MedVantage reserves the right to correct any such errors and disclaims liability resulting therefrom. 

Data Backup 
MedVantage is not responsible for any loss of data entered into the system. The User shall be fully responsible for 
performing any required backup or data protection.  

Limitation of Liability 
In no event shall MedVantage or anyone else involved in the creation, production, or delivery of the accompanying 
product (including hardware and software) be liable for any damages whatsoever (including, without limitation, 
consequential damages including loss of business profits, business interruption, or loss of business information) arising 
out of the use of, the results of use of, or inability to use such product, even if MedVantage has been advised of the 
possibility of such damages. Some jurisdictions do not allow the exclusion or limitation of incidental or consequential 
damages, so the above limitation or exclusion may not apply to you. 
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1. GETTING STARTED 

System Overview 
The FreshDate 3 System includes: 

 

FreshDate 3 Device – Label printer with a modern Android operating system and 10.1” 
display 
 

 

Prep - Printer application for printing labels, viewing recipes, and watching videos. 
 

 

Configure – Desktop and printer application to setup users, send/receive files, configure 
printers and network settings. Set printers to push/pull updated data files. Get log, 
configuration, and data files from your printers. 
 

 

 
 
Edit – Desktop and printer application to create product data files, batches, timers, 
manage media files, and add custom formats. 
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About the Printer 
 

 

 

 

 

 

 

 

 

  

1. Cover 6. Power Cord Connection 11. Power Button 

2. Display 7. Ethernet   

3. Left Printer 8. HDMI  

4. Right Printer 9. USB (Type B)  

5. Speaker 10. USB (Type A)  
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About User Roles 
FreshDate 3 has three types of users:  Operator, Manager, and Administrator. The system comes with one default User ID 
and Password for each User Type. Login as the default Admin to create users. The default users may be removed once a 
new Admin is created.    

User Type Description Default User ID - Password 

Operator Most basic-level user with access to Prep.  Can print labels and 
may be able to update product data files on the printer. 

operator - 0000 
The operator password is 
optional. The system admin 
decides if operators must login 

Manager Middle-level user with access to Prep.  They may be able to 
update product data files, use Edit, configure printers, etc. 

manage - abcd 

Administrator Most advanced-level user with access to all applications. This 
user sets the permissions for operators and managers. 

admin - 1234 

 

Note: We recommend changing the default User IDs and Passwords and/or defining your own users. 
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Setting Up the System 
As a System Administrator or a Manager, follow these steps to get the FreshDate 3 system up and running: 

1. Set up the printer. Determine a location for the printer. The printer can be table-top, shelf or wall mounted using the 
built-in bracket. Plug the power cord into the connection on the side of the printer, and into a grounded electrical 
outlet. Press the red power button on the side of the printer. 

2. Log On. See the Logging On/Off section below. 

3. Print Labels. See the Using Prep section below. 

4. To add users, edit the store info, and send or get data from network printers, see the Using Configure section below. 

5. FreshDate 3 comes with pre-loaded product data. To add or make changes to product buttons, quick labels, batches, 
videos, documents, and images, see the Using Edit section below. 
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2. LOGGING ON/OFF 
The Log On screen is divided into four tabs: Operators, Managers, Administrators, and All Users. These tabs organize user 
accounts by role.  

To log on, click your user account icon.  

 

To log off, change your password, select your language, click your user account icon on the top left corner of the screen 
then select LOG OUT. The system returns to the log on screen. 
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3. SWITCHING BETWEEN APPLICATIONS 
Navigate between applications using the apps menu icon on the top-right side of the screen.  

Your System Administrator may have defined the Manager role to have limited/restricted access to applications.  

Note: The time it takes to switch between applications is affected by the size of the application and data being loaded. 

To logout as a Manager or Administrator, use the apps menu icon, then press Log Out.  
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4. USING PREP 
Use the Prep application for printing labels, viewing recipes, watching videos, and more.  

When you log on as Operator, the printer automatically starts Prep.  

When you log on as Manager or Administrator, press the Prep icon on the bottom of the Home screen.  

 

This section contains basic instructions on Prep. For complete instructions, press the Help and About icon on the top-right 
corner of the screen, or see the Using the Prep Application manual. A copy is found in the flash drive that comes with the 
FreshDate 3 system.  
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Printing Labels 
To print labels: 

1. Press the Product Button you want to print. 

 
 

 

 

 

 

 

 

 

 

 

 

2. Depending on the label format, you may be prompted to enter data or may have the option to edit data. 
3. Enter the number of labels you need. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4. Press Print. 
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Searching 
To search for a product button, batch, quick label, or media file: 

1. Click the search bar at the top of the screen to open the keypad. 
2. The default search is set to All. Press the drop-down arrow to filter the search by product buttons, batches, quick 

labels, or media files.  
3. Type your search criteria. As you type, the results are listed below.  

Note: Typically, listing results takes longer on the first search and less on subsequent searches.  
4. Click the search result you need then click the search button (magnifying glass icon).  
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5. USING CONFIGURE 
Use the Configure application to setup users, store info, configure network settings, add printers, send and get files from 
printers, and more. 

Configure can be used on the printer or a PC.  

Note: We recommend using Configure on the printer only for minor changes, like editing store info. For major changes, 
like creating/editing multiple uses, Configure on PC typically offers faster performance.  

 

To use Configure on the printer, log on as Administrator and, on the bottom of the Home screen, press the Configure 
icon.  

To install Edit and Configure on a PC, double-click the installation file. A copy is found in the flash drive that comes with 
the FreshDate 3 system.  

To use Configure on PC, double-click the Configure icon on the desktop.  

This section contains basic instructions on Configure. For complete instructions, press the Help and About icon on the top-
right corner of the screen, or see the Using the Configure Application manual. A copy is found in the flash drive that 
comes with the FreshDate 3 system.   
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Setting the Date and Time 
To set the date and the time on the printer: 

1. In Configure, tap the General Settings icon from the left menu, then Date & Time tab.  
 

 
 

 
 

2. Make any adjustments to the Date Format, Date Separator, Time Format or Time Separator.  
3. Tap Set Date & Time.  
4. If the printer is connected via Wi-Fi or Ethernet, enable Automatic date & time to use your network-provided date 

and time information. Your network sets daylight saving time as required in your region. 
5. If the printer is not connected via Wi-Fi or Ethernet, manually set the date and time, and manually adjust the time for 

daylight saving time as required in your region. 
6. Select the time zone.  
7. Enable or disable Use 24-hour format.  
8. You do not need to save your settings; they are automatically saved when you navigate away from this screen.  
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Configuring Network Settings 
Configure network settings in Configure to add network printers. 

Configuring LAN Settings  
For the LAN network connectivity, decide the method of obtaining an IP address:  

• Use DHCP for obtaining IP address automatically. 

• Use static IP address. Then, enter the IP Address, Subnet Mask, Default Gateway, Primary DNS and Secondary DNS 
information.  

To change the LAN settings on the printer/tablet:  

1. Tap the Network icon from the left menu, then LAN tab.  
2. Enable Use DHCP to obtain IP address automatically -OR- Use static IP address.  
3. If using a static IP address, enter the IP Address, Subnet Mask, Default Gateway, Primary DNS and Secondary DNS 

information.  
4. Tap Save Settings.  

To change the LAN settings using a configuration file:  

1. Press the Network icon from the left menu, then LAN tab.  
2. Disable Use Printer Settings.  
3. Enable Use DHCP to obtain IP address automatically -OR- Use static IP address.  
4. If using a static IP address, enter the IP Address, Subnet Mask, Default Gateway, Primary DNS and Secondary DNS 

information.  
5. Save the configuration file when you are finished.  

Configuring Wi-Fi Settings  
Set the Wi-Fi connectivity by entering the following:  

• Service Set Identifier (SSID), which is the wireless network name.  

• Security of the wireless network as None, WPA-PSK, or WPA2-PSK. 

• Network password.  

To change the Wi-Fi settings on the printer/tablet: 

1. Tap the Network icon from the left menu, then Wi-Fi tab.  
2. Tap Wireless.  
3. 3. Select your network from the list.  
4. Enter the network password.  
5. Tap Connect.  
6. You do not need to save your settings; they are automatically saved when you navigate away from this screen. 

To change the Wi-Fi settings using a configuration file:  

1. Press the Network icon from the left menu, then Wi-Fi tab.  
2. Disable Use Printer Settings.  
3. Enter the network name (SSID).  
4. Select the security.  
5. Enter the network password.  
6. Save the configuration file when you are finished.  
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Adding Printers 
Add printers to Configure on PC to send or get files.  

To autodiscover network printers: 

1. Press ADD PRINTERS or press the file menu icon on the top-left side of the screen and then select Add Printers from 
the drop down. 
 

 
 

2. Select Autodiscover network printers, and then press NEXT. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Any discovered printers are listed. Press NEXT and ADD PRINTERS.   
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Sending and Getting Files  
Whenever a printer or group is selected, send one of the following file types:  

• Application (.APK) file - update the application.  

• Configuration (.ENC) file - change the configuration. The printer reboots automatically whenever it receives a 
configuration file. On the tablet, the configuration file is applied without a restart.  

• Data file (.DAT, .DAT18, .FRESHDATE) - change the product data file.  

• Video (.MP4 or .WEBM) files to the Media storage.  

• Documents (.PDF) files to the Media storage.  

To send files:  

1. Select the Printer and click Send.  

 
2. Only Managers and Administrators can send files to the printer using their User ID and Password. User ID is case 

sensitive. When the initial configuration file (specifying users) is sent to the printer, use the default Manager account.  
3. Navigate to the file to send.  
4. Select the file(s).  
5. The file is transferred to the selected printer or group. 

To get files: 

1. Select the Printer and click Get. 

 
2. Select which file you want to download onto your PC.  
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6. USING EDIT 
Use the Edit application for creating product data files, batches, timers, adding videos and documents, and more. 

Edit can be used on the printer or a PC.  

Note: We recommend using Edit on the printer only for minor changes, like a price change. For major changes, like 
creating/editing multiple product buttons, Edit on PC typically offers faster performance.  

 

To use Edit on the printer, log on as a Manager or Administrator and, from the Home screen, press the Configure icon.  

To install Edit and Configure on a PC, double-click the installation file. A copy is found in the flash drive that comes with 
the FreshDate 3 system.  

To use Edit on PC, double-click the Edit icon on the desktop.  

This section contains basic instructions on Edit. For complete instructions, press the Help and About icon on the top-right 
corner of the screen, or see the Using the Edit Application manual. A copy is found in the flash drive that comes with the 
FreshDate 3 system. 
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About Product Buttons  
A button can have multiple functions. Button functions are assigned by the System Administrator. Label Each product 
button can print up to four labels.  

Timer: A product button can include a timer. When you press the button, you can start the timer.  

Video: A product button can include a video. When you press the button, you can watch the video.  

Document: A product button can include a document. When you press the button, you can view the document.  

Prompt: A product button can include a prompt message. Read the message and follow any instructions. Click Cancel to 
go back to the product buttons screen; click Done to return the remaining button functions.  

Buttons with multiple functions (label + timer, label + video, label + document, etc.) are shown with the three vertical dot 
icon in the bottom right corner. This icon lets you know the button has more than one function.  

For example, a button, Cheesecake may start a timer for how long the cheesecake needs to thaw, show a video about 
making the cheesecake, display the cheesecake recipe, and print a nutrition label, ingredient label, prep label, and 
receiving label.  

When a button only has one function (timer, video, or document), an icon appears in the bottom right corner on the 
button indicating its function.  

Product buttons with multiple functions display the more icon (vertical dots). 
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Creating Product Buttons  
The System Administrator or Store Manager creates buttons. Buttons are part of your data file. The data file contains all 
product buttons, batches, timers, videos, and associated documents.  

Create up to 60 buttons per tab. Only 20 buttons are visible on the screen at a time - scroll to see the remaining buttons. 
Each category may contain up to 25 tabs, each tab may contain up to 60 buttons.  

Buttons inherit the default button function (label, timer, video, document) set in their category or tab. However, each 
button may use a different format.  

A button can have multiple functions. For example, three buttons on Tab 1 use Format 1, six buttons on Tab 1 use Format 
2, and the rest use Format 3 (set in Category Properties).  

Your System Administrator may have defined the Manager role to have limited/restricted access within Edit. Do you 
already have product data in a spreadsheet? See Importing Product Data for more information.  

To create/edit a button: 

1. On the left menu, press Product Buttons. 
2. Click + to add a new button or click the button to edit. The Button Properties screen opens.  
3. Enter a Button Name. Button Names are limited to 30 characters.  
4. Click Upload Image to add an image to a product button. Navigate to the image and click Open. See Adding Images to 

Buttons.  
5. Click Add Function, then Label to create a label button.  
6. Select which printer (Left or Right) will print the label (only valid on dual printers). The tablet system is a single printer. 

The Left printer is the default. In Prep, users may select either the Left or Right printer before printing a label. For 
example, if the left printer is out of supplies, the operator can print labels to the right printer.  

7. Select the Format from the drop-down list. See Standard Format Library.  
8. Enter the information required for each format. The format selected in a tab applies to all buttons within the tab. 

However, each button may use a different format. Each button can print up to four different formats.  
9. Enter the Descriptions for the button. Certain information may be Bold, Italic or Underlined. Select the appropriate 

icon (B, I, or U) as necessary.  
10. Enter the Prep, Ready, and Use By Duration. See Creating Editable Labels.  
11. Change the default text for "Prep," "Ready," or "Use By" if necessary. See About Freshness Labeling.  
12. Enter the ingredients and allergens, changing the default text for "Ingredients" or "Allergens" if necessary. To enter a 

line break within your data, use {x}. For example, "...fruit juice concen-{x}trate...".  
13.  Enter any nutritional information.  
14. Enter the barcode data.  
15. Select the images to use for Image 1, Image 2, etc. as necessary.  
16. Enter the data for any remaining fields, as necessary.  
17. Select Preview Label to see a print preview at any time.  
18. Click Done when finished. The file is saved automatically or select Save or Save As from the File menu to save the file 

with a new name.
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Using the Excel Template 
Use the spreadsheet template to enter data (or copy from an existing spreadsheet/.CSV file).  The template works with 
Microsoft® Office Standard 2010 version of Microsoft® Excel®.  

• A spreadsheet template with sample data is found on the USB flash drive. To download a blank spreadsheet template 
from the Edit application, select Download Excel Template from the File menu.  

• To enter data, open the template in Excel and select the Data tab on the bottom of the page. 

• Use categories to organize your data. Create up to 20 categories, 25 tabs per category and 60 buttons per tab. 

• Tool tips exist for field values. Select the header name to see more information.  

• Data pasted from other Excel worksheets must be formatted as General or Text. Data from cells in other formats, 
such as Numeric or Percentage, may not import properly. 

• More help is found on the Help tab on the bottom of the template. 
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Updating the Printer 
To update the printer’s data file, configuration file, or application using a USB flash drive: 

1. Copy the file to be update onto the root of a flash drive.  
2. Plug the flash drive into the USB port on the side of the printer.  
3. Log on as a Manager or Administrator. 
4. On the bottom of the Home screen, press the Prep icon. 
5. On the left menu, press the Printer Settings icon.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
6. Select Print Update and Update Data File. Select the file you want to upload.  
 

Note: If the “No USB 
devices connected.” 
message appears, and 
the flash drive is plugged 
into the printer, there 
may be a formatting 
issue with the flash 
drive. Follow the 
Formatting a Flash Drive 
instructions below and 
start again. 
 
 
 
 
 
 
 
 
 

7. Once the update is complete, remove the flash drive from the printer.  
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Formatting a Flash Drive 
To format a flash drive on the FreshDate3 printer: 

1. Plug the flash drive into the USB port on the side of the printer.  
2. Log on as Administrator. 

 
3. On the left side of the Home screen, press the Android icon. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Press the button located on the bottom of the screen (Note: You may need to swipe up on the screen if there are 
notifications present). 
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5. Click on Settings. 

 

 

 

 

 

 

 

 

 

6. Click on Storage. 

 

 

 

 

 

 

 

 

 

7. Select the USB drive. 
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8. On the top right corner, select the 3 dots and “storage settings”. 

 

 

 

 

 

 

 

9. Click Format. 

 

 

 

 

 

 

 

 

10. Click Erase and Format (Note: Everything on the USB drive will be erased so please have a backup copy of your files). 
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7. SAFETY INSTRUCTIONS 
The equipment is designed to be compliant with the rules and regulations in the locations into which it is sold and will be 
labeled as required. Any changes or modifications to the equipment not expressively approved by MedVantage could void 
the user authority to use operate the equipment. 

1. Follow all cautions and instructions marked on the equipment. 
2. Do not operate the equipment without the covers in place. It may damage the equipment or cause personal injury. 
3. Never push objects of any kind through openings on the equipment. Dangerous energy might be present and cause 

fire, electric shock, or damage to the equipment. 
4. Do not block or cover the openings of the equipment. 
5. Do not place the equipment near a radiator or heat register. This could cause the equipment to overheat. 
6. Do not place the equipment in a location where it can get wet.  Personal injury could result. 
7. The equipment is designed to work with power systems that have a grounded neutral grounded return for DC-

powered equipment). Do not plug equipment into any other type of power system. This could cause electric shock. 
Contact your facilities manager or qualified electrician if you are not sure what power supply you have.  
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8. CARE & MAINTENANCE 

Cleaning the Printer 
Slightly dampen a cloth with water and wipe off the printer’s case. Open the cover and use a dry, soft-bristled brush to 
remove paper dust.  

Caution: Do not use household cleaners to clean the printer. 

Cleaning the Display 
Make sure the printer is turned off when cleaning the display.  Use a soft, lint-free cloth to wipe the display. 

Caution:  Do not use sharp objects or abrasive cleaners on the display; they can cause damage. 

Clearing Label Jams 
1. Open the cover.   
2. Tear the supply and remove the label roll. 
3. Remove the jammed labels. 
4. Remove any adhesive that might be on the platen roller.  See Cleaning the Platen Roller and Printhead below for more 

information. 
5. Reload the labels.   
6. Close the cover. 

Caution: Do not use sharp or pointed objects to remove labels. It may damage the printer.  

Cleaning the Printhead with the Cleaning Card 
1. Open the cover.   
2. Remove any previously loaded labels. 
3. Remove an unused Thermal Printer Cleaning Card from its pouch and feed it through the slot (behind the white 

roller).  A portion of the Cleaning Card will feed through. 
4. Close the cover with both hands pull on the Cleaning Card through the front of the printer. 
5. Repeat as needed. 
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Cleaning the Platen Roller and Printhead 
Clean the platen roller and printhead after every five rolls of labels or when you see voids in the print. 

     

1. Remove any labels. 
2. Use a plastic utensil to remove the supply slot cover. 

 
3. Use the plastic utensil to press the L-shaped bar. The platen roller is released. You may need to slightly open the 

front cover to eject the platen roller. 

 
4. Use the plastic knife to press the L-shaped bar.  The platen roller is released.  You may need to slightly open the 

front cover to eject the platen roller. 
5. Clean the platen roller and printhead using a cotton swab moistened with isopropyl alcohol. 

 
6. Allow time for the parts to dry. 
7. Replace the platen roller. 
8. Snap the cover into place. 
9. Reload the labels.  
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9. TROUBLESHOOTING 
This section lists some common printer problems and solutions. 

Problem Action 

The screen is off or the printer is not 
responding. 

Press the Power Button to turn the printer off, press it again to turn the printer 
back on.  If the printer will not turn off, unplug it from the outlet, wait 10 
seconds, then plug it back in. 

The printer does not print, has voids, 
or is too light. 

Make sure the printer is turned on and has power. 
Correctly load supply. 
Clean the printhead. 

Printing stops OR the printer does 
not correctly advance from one label 
to the next. 

Clear any jammed labels. 
Correctly load supply. 
Make sure your printer is turned on and has power. 
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10. LABEL STORAGE RECOMMENDATIONS 
Labels should be stored at a temperature of 22°C ±2 and at a relative humidity of 50% ±5. The nearer to these conditions, 
the better. Further recommendations are as follows: 

• Store in original packaging 

• Store away from direct sunlight 

• Rotate stocks so that the oldest labels are used first 

• Store label rolls horizontally, not vertically 

• Ensure that winding tension of label roll is not too tight, to prevent adhesive bleed 

• Do not hang rolls of labels on pegs, or stack them in such a way that the inner core is distorted 

• Repack partly used rolls of labels in their original packaging. 
 

NOTE: Storage at too high a temperature may have a detrimental effect on a product's performance. Low temperatures 
are generally less critical, but thorough subsequent reconditioning is nevertheless important to avoid conversion or 
dispensing problems. 

Shelf life  
The shelf lives of MedVantage labels include a guarantee on adhesive performance. For most products a shelf life 
guarantee of two years is given. Some exceptions, with only one-year shelf life, are Piggyback constructions; as well as 
products with a high coat-weight and select service products with over 50% increased adhesive weight. Other exceptions, 
with only 6 months shelf life, are Thermal Transfer Poly labels. It should be noted that materials stored for a longer period 
than the maximum shelf life indicated will generally still allow trouble-free conversion. If in doubt, we recommend testing 
of release and adhesive performance. 

Handling 
Recommendations as follows: 

• Remember that label roll cores are at their most vulnerable on the extreme edges. Handle with care 

• Rough handling of label rolls can cause the core and/or edges to become damaged. Eventually, this can lead to 
breakage on the printer machine 

• Avoid leaving label rolls in areas where they can be damaged by heavy items that could bruise or crush the edges. 

Warranty 
All statements, technical information and recommendations about MedVantage label products are based upon tests 
believed to be reliable but do not constitute a guarantee or warranty. All MedVantage products are sold with the 
understanding that PURCHASER has independently determined the suitability of such products for its purposes. 
MedVantage products are warranted to be free of defects or workmanship for a period 30 days from delivery; after which 
the customer assumes all responsibility for the product. Any product shown to the satisfaction of MedVantage within the 
time provided to be so defective shall be replaced without charge or MedVantage may issue credit in such amount as it 
deems reasonable however, in no event shall MedVantage be responsible for claims beyond the replacement value of the 
defective product or in any way liable or responsible for consequential or incidental damages. 

NO EXPRESS WARRANTIES AND NO IMPLIED WARRANTIES, WHETHER OF MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR USE, OR OTHERWISE, EXCEPT AS SET FORTH ABOVE (WHICH IS MADE EXPRESSLY IN LIEU OF ALL OTHER 
WARRANTIES) SHALL APPLY TO PRODUCTS SOLD BY MEDVANTAGE. MEDVANTAGE SPECIFICALLY DISCLAIMS AND 
EXCLUDES ALL OTHER SUCH WARRANTIES. NO WAIVER, ALTERATION, ADDITION OR MODIFICATION OF THE FOREGOING 
CONDITIONS SHALL BE VALID UNLESS MADE IN WRITING AND SIGNED BY AN EXECUTIVE OFFICER OF MEDVANTAGE. 

No salesman, representative, or agent of MEDVANTAGE is authorized to give any guarantee, warranty or make any 
representation contrary to the above. 
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11. TECHNICAL SUPPORT 
MedVantage strives to ensure customer satisfaction through excellent service and products.  If you are experiencing any 
issues with your printer(s) or labels call or email anytime during business hours. To be eligible for the FreshDate Service 
Program, the account must be an active customer who purchases consumables from MedVantage.  Technical Support 
aims to have a turnaround time of 5 business from receipt of the printer. 

Business hours: (M-TH 8:30 AM to 4:30 PM ET, FR 8:30-3:00 PM ET)  
Phone: 201-587-9100  
Email: support@medvantage.org.  

MANUFACTURER’S WARRANTY 
One (1) year Parts and Labor. Thermal Print Head, six (6) months or one (1) million Inches; whichever occurs first.  

OUT OF WARRANTY REPAIRS  
1) Cost: Based on time and materials.  
2) Purchase Order: For expedient turnaround time we require a $350 blanket PO prior to diagnostic services.  The $350 

will be applied towards repair costs.  For repairs under $350 the Customer will be billed accordingly. For any work 
above $350 the Customer will be sent a quote & an updated PO must be submitted prior to completing any repairs.  

3) If the Customer does not wish the printer to be repaired, a $66 diagnostic service fee will be charged.  

LOANER PRINTERS   
MedVantage maintains a fleet of loaner printers for Customers to use while their own units are being repaired or 
assessed. The program is based on availability and allows Customers to remain operational with little to no downtime.  
1) Loaner Fees: $200 per incident (price may vary by location).  
2) Return Authorization Number: Customer must contact Tech Support to request a Return Authorization Number (RA#) 

and shipping instructions. 
3) Purchase Order: For expedient turnaround time we require a $550 blanket PO prior to shipment of loaner printer.  

The $550 will be applied towards repair costs and loaner fees.  For repairs under $550 the Customer will be billed 
accordingly. For any work above $550 the Customer will be sent a quote & an updated PO must be submitted prior to 
completing any repairs.  

4) Additional Fees: Loaner printers must be returned to MedVantage immediately. An additional fee of $20 per day may 
be charged if the Customer does not ship their defective printer to MedVantage within five (5) business days of 
receiving the loaner printer or does not ship the loaner printer back to MedVantage within five (5) business days after 
receiving the repaired printer.  

DATA CONVERSIONS 
1) The fee to convert a standard datafile is $150. For a non-standard datafile (contains custom format(s) or applications), 

additional fees may apply. To obtain pricing in advance, contact Support and provide the datafile to be converted. 

TERMS & CONDITIONS 
1) Shipping: The Customer is responsible for inbound transportation charges. MedVantage is responsible for outbound 

transportation charges, UPS Ground. Higher priority shipment is available at Customer’s expense. 
2) Packaging: Printer(s) being returned must be packaged in a manner to ensure they are received without damage, 

ideally in the box you received it in. Printers damaged in transit from the Customer to MedVantage are responsibility 
of the customer. Insurance up to $1975 is suggested.  

3) Loss or destruction of the product is not covered under this Service Program.  
4) Warranty does not include any condition resulting from other than ordinary wear or any use for which the product 

was not intended. 
5) Only genuine labels and supplies are recommended for use in our products. The warranty does not cover service 

required due to the use of non-recommended supplies. Labels must also be shipped back with printer for evaluation. 
 
**Subject to change without notice ** 



 

 

 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

230 West Passaic Street 
Maywood NJ, 07607 

 

Call: 201-587-9100 

Email: support@medvantage.org  

Visit: www.medvantage.org  
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